Mechatronics Design – Class#11

Liwei Lin

Professor, Dept. of Mechanical Engineering
Co-Director, Berkeley Sensor and Actuator Center
The University of California, Berkeley, CA94720
e-mail: lwlin@me.berkeley.edu
http://www.me.berkeley.edu/~lwlin
Outline

◆ Review on Labs
Lab #1

ME102 Lab 1: Getting Started

This lab will teach you how to setup the IDE (Integrated Development Environment) for the Arduino. These instruction have been tested for the computers available in lab. However, it is just as easy to setup the IDE on your own laptop. You may wish to do this for future lab assignments.

1. Introduction to the Arduino
   • Kit contents check
   • Arduino IDE and some terminology
   • Hello Worlds
   • Anatomy of a sketch
2. Setting up your hardware buffers
   • Digital input buffering with the 74LS14
   • Digital output buffering with the 7417
   • ADC setup with the 4342
3. Clean up and check off
   • Blinking LED with the buffered setup
4. References
Lab Kit

Kit contents check

Before we continue any further, please make sure that you have at least the following in your lab kit.

- 1 Arduino Duemilanove
- 1 USB A-B cord
- 1 breadboard
- 5 LED’s of assorted colors
- 2 tactile switches
- 1 DC motor
- 1 tiny RC servo
- 1 potentiometer
- 1 optical encoder (datasheet)
- 1 pair of wire cutters
- 1 74LS14 (datasheet)
- 1 DM7417 (datasheet)
- 1 OPA4342 (datasheet) or TLV2374I (datasheet)

If you have any problems identifying your parts, please notify a GSI.
If you are missing any parts, please find Tom Clark.
Arduino
The largest benefit of the Arduino is the fact that you are not limited to programming in the lab. Instructions on how to install a copy of the Arduino IDE on your own machine can be found [here](#) (Mac, Windows and Linux).

Start the Arduino IDE by clicking the Arduino icon on the desktop.

For those of you who are familiar with microprocessor programming, the first thing you will notice is the Arduino’s minimalist approach.

There are 7 shortcut commands that you can use with the Arduino IDE:

- **Serial Monitor** opens the only debugging tool you have with the Arduino. The Serial Monitor displays information passed from the Duemilanove to the computer.
- **Upload** compiles your program (“sketch” in the parlance of the creators of the Arduino), and sends it to the board if there are no compile-time errors.
- **Save** your sketch
- **Open** an existing sketch
- **New** creates a new sketch
- **Stop** interrupts compilation of your code.
- **Compile** your sketch in order to check for compile-time errors. As your sketch grows in size, it’ll save time to verify that your code compiles before trying to upload it.
1. Tools → Board (select the right Arduino version)
2. Computer → Device Manager → Ports → USB Serial (COM3)
3. Tools ➔ Serial Port ➔ COM3
5. Files → Examples → Stubs → HelloWorld (load the program)
6. Verify the Screen (successful communication)
6. File → Examples → Digital → Blink (load a new program)
Software Introduction – “HelloWorld”

```java
void setup() {
    Serial.begin(9600);
}

void loop() {
    Serial.println("Hello World!");
}
```

- `Serial.begin(9600);`: Serial communication
- `Serial.println("Hello World!");`: Serial print on screen
- `void setup()`: where to use the board
- `void loop()`: never-ending loop
- `Serial.begin(9600);`: please find out this yourself
Software Introduction – “Blink”

```c
int ledPin = 13; // LED connected to digital pin 13

void setup() {
    pinMode(ledPin, OUTPUT);
}

void loop() {
    digitalWrite(ledPin, HIGH);
    delay(1000); // wait 1000 ms
    digitalWrite(ledPin, LOW);
    delay(1000);
}
```

pin 13 is output
Hardware - Setup

◆ Set 5Volt on one rail of the breadboard
◆ (the breadboard can also be powered by the Arduino board but the current is limited to 50mA by the Arduino)
◆ Connect the common ground (0Volt) to one rail of the breadboard
Digital Output Buffer – DM7417

Digital output buffering with the DM7417 (datasheet) protects the Arduino. The DM7414 is a hex buffer with open collector high voltage output. An open-collector only guarantees that a LOW input results in a LOW output. There are no guarantees for a HIGH input.

```
Pin 1 Indicator
IN OUT GND GND
```

```
Vcc 5V
```

```
Digital Signal
```

```
5v
```

```
“pull-up” resister R~10kΩ
```

```
Digital output
```

Liwei Lin, University of California at Berkeley
Digital Output Problem – “Floating”

floating $\Rightarrow$ gradually to high $\Rightarrow$ electrical noise
Digital Output Problem – “Short”

$V_{cc} = 3.3\, \text{V}$

When grounded $\rightarrow$ short circuit from $V_{cc} \rightarrow$ ground
Pull-Up Resistor

By using a pull-up resistor on the output end, one can supply any level of voltage within the operational specifications of the IC. For the DM7414, it is 15V.

The basic function of a pull-up resistor is to insure that given no other input, a circuit assumes a default value. Consider the circuit in “Configuration of DM7417”, when the digital signal input is HIGH, the IC acts as a high impedance part so current flows to the right. When the digital signal input is LOW, the IC becomes a current sink. IN order to prevent IC destruction, pull-up resistors are generally in the range of 10k to 47k ohms. Special cases do exist as you will see at the check-off task.
Pull-up Resistor

\[ V_{cc} \quad \text{pull up resistor} \quad 10k \sim 47k \Omega \]
Digital Output Buffer – DM7417

+5 VDC

Output

3.3V

10k

A

B

Output

Output

A | B
---|---
1 | 1
0 | 0

Output sees high (3.3 V)

Output sees ground
Digital Input Buffer – 74LS14

To buffer the digital input of the Arduino, we use the 74LS14 (datasheet). The 74LS14 is a hex Schmitt trigger inverter. It takes a digital input and outputs the opposite. HIGH becomes LOW, and LOW becomes HIGH. In TTL (Transistor-to-Transistor Logic), a HIGH signal is anything from 2.2V to 5V whereas a LOW signal is anything from 0V to .8V. The area from .8V to 2.2V is essentially undefined behavior. The Schmitt trigger is a property of this particular chip that allows it to be slightly less responsive to noise. And finally, there are six such inverters on a single chip (hence hex).
Digital Input for DSP

digital input

0 - ground
1 - 3.3V

no real power
Schmitt Trigger – Comparator

Vin \rightarrow V_{\text{ref}} \rightarrow V_{\text{out}} = V^+

Vin < V_{\text{ref}} \rightarrow V_{\text{out}} = V^-

Liwei Lin, University of California at Berkeley
Schmitt Trigger – Signal & Noise
Schmitt Trigger – Reject Interference
Schmitt Trigger – Circuit

\[ V_{\text{in}} = V_{\text{ref}} = V_{\text{out}} \left( \frac{R_1}{R_1 + R_2} \right) \]

\[ \begin{align*}
  V_{\text{in}} < V_{\text{ref}} & \quad \Rightarrow \quad V_{\text{out}} = V_{\text{set}} \\
  V_{\text{in}} > V_{\text{ref}} & \quad \Rightarrow \quad V_{\text{out}} = V_{\text{sat}}
\end{align*} \]
Schmitt Trigger – Responses

\[ V_{\text{in}} = V_{\text{set}} = V_{\text{out}} \frac{R_1}{R_1 + R_2} \]

Vin (temperature)

Liwei Lin, University of California at Berkeley
ADC (Analog-to-Digital Conversion)

We protect the ADC with a voltage follower. In your lab kits, you may either have a OPA4342 (datasheet) or a TLV2374I (datasheet). Both are suitable for our purposes.

Verify that there is unity gain or $\text{Vin} = \text{Vout}$ for your voltage follower. You can easily do this by connecting the wiper of your potentiometer, which has been connected between 5V and ground, to the non-inverting input ($+\text{In C}$). The wiper is the part that changes voltage as the knob turns.
Lab #1

The check off for this lab is a blinking LED that works with your buffered system.

1. Connect Pin13 to the one of the 7417’s inputs
2. Connect the corresponding output from the 7417 to the anode of the LED.
3. The pull-up resistor limits current flow. With a 10k resistor, current flow through it is limited to .5mA. This is not enough to drive an LED. Given that the SN7417 can sink 40mA, use a resistor of around 1k ohms as your pull-up resistor.
4. Note that the onboard LED and your recently connected LED should blink in phase.
Lab #3 – DC Motors

DC Motors and the TA7291P H-bridge

In Lab 1, we used buffer IC’s (7417, 7414) to isolate the signals to and from the Arduino. This protected the board, and provided power for external devices without drawing it from the Arduino. An H-bridge can be thought of in much the same way. It is the interface between an electrical signal and an electrical power source. Though they share the same medium, their functions are vastly different.

The H-bridge is a common circuit used to control the speed and direction of a DC motor with low current PWM signals. The H-bridge you will be using is the TA7291P (datasheet). It is a pair of half bridges that can source 1 Amp.
H-Bridge

current can go either way to the motor by controlling the on-offs of AHI, ALD, BHI, BLD.
## H-Bridge Functionalities

<table>
<thead>
<tr>
<th>INPUT</th>
<th>OUTPUT</th>
<th>MODE</th>
</tr>
</thead>
<tbody>
<tr>
<td>IN1</td>
<td>IN2</td>
<td>OUT1</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>H</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>L</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>L</td>
</tr>
</tbody>
</table>
H-Bridge Characteristics

- bi-directional current switch with intrinsic protection diodes
- current sensing LMD 18200
- over current protection
- thermal warming/shut down
- sign/magnitude control
- Braking
Hardware Connections

Diagram showing the connections between Arduino and a TA7291P chip, with labels for inputs and outputs:
- Arduino
- TA7291P
- Motor

The diagram includes labels for Vcc, Vref, Vs, IN1, IN2, OUT1, OUT2, GND, and NC.
Half-Bridge

DC motors are turned on by applying a voltage across the two terminals. The rotation speed can be controlled by increasing or decreasing the applied voltage. Changing the polarity of the applied voltage changes the motor’s direction of rotation.

We can use half bridges to control both the speed and direction of rotation of a DC motor. Half bridges are essentially high power digital buffers; the output goes to 0V when the input is low, and the output goes to Vs when the input is high. To power a motor, we can use half bridges to drive one terminal high and the other low.
PWM (Pulse Width Modulation)

- Microprocessor
  - Digital output
- Analog circuit
  - Infinite resolution
  - May get hot, noise...
  - Change the output value
Example

9 volt battery to a light bulb

50 ms on
50 ms off

50% duty cycle → bulb feels it were connected to a 4.5 V battery
Lab Test

IN1 (pin 5)

IN2 (pin 6)

$V_0_1 - V_0_2$

MOTOR SPEED: SLOW MEDIUM FAST

Average current flows from output 1 to output 2

Average current flows from output 2 to output 1
Software Tasks

Throttle Control

Control the direction and speed of the provided DC motor with a potentiometer. The motor should behave like the throttle of a boat. A potentiometer twisted all the way to the right should have the motor spinning fast in one direction. As the potentiometer is twisted left, the motor should slow down and then begin spinning the other direction.

Mimicking motion

Tie the direction and speed of the motor spinning to the direction and speed of the potentiometer rotation. The faster you spin the potentiometer, the faster the motor should spin.
Open-Loop Control

Fan

\[ \text{if } \omega = A_i \cdot I \]

angular velocity

\[ \uparrow \]

current

\[ \uparrow \]

transfer function

\[ I \rightarrow A_i \rightarrow \omega \]
Feedback Control
Example - Circuit

\[ V_0 = AV_S \]
\[ dV_0 = A dV_S + V_S dA \]

\[ d\frac{V_0}{V_0} = \frac{dA}{A} \]

If \( A \) changes 1%, \( V_0 \) changes 1%
Feedback Circuit

\[ V_o = AV_s = A(v_i + \beta v_d) \]

\[ V_o (1 - A\beta) = AV_i \]

\[ A_f = \frac{V_o}{V_i} = \frac{A}{1 - A\beta} \]

(close-loop gain)
Example – 741 Amplifier

e.g. 741 amplifier: $A \approx 2 \times 10^5$

if $B = -0.1$

$\Rightarrow A_f = \frac{2 \times 10^5}{1 - 2 \times 10^5 (-0.1)} \approx 10$

if $A$ change $+1\% \Rightarrow A_f = 9.9999$